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Install BioStone Animal Health

- “BioStone ELISA Setup.exe” is run for installation.
- The program is installed in the "C:\BIOSTONE\ELISA" folder.
- The program will ask for a license code for installation.
- To obtain this code, contact BioStone and request your special code. (Phone,WhatsApp,Mail)
( Your PC must have an internet connection at that time in order for the program to receive license approval.)

Y
™
BIOSTONE
ANIMAL HEALTH
Cancel Check License Code

) Setup - BioStone Elisa version 0.0.0.78 - X
TInstalling —
Please wait while Setup installs BioStone Elisa on your computer. o
S
Creating shorteuts....
C:\ProgramData Micr i t Eisa.nk

) Setup - BioStone Elisa version 0.0.0.78

Completing the BioStone Elisa Setup
Wizard

Setup has finished instaling BioStone Eisa on your computer. The
application may be launched by selecting the installed shortcuts.

Click Finish to exit Setup,

Launch BioStone Elisa

=

Back to Index
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Install BioStone Animal Health

- The BioStone ELISA Program is ready to run.
- Create your company name and Admin password.

%] x|
<4 L4
BIOSTONE"™ BIOSTONE ™
ANIMAL HEALTH ANIMAL HEALTH
Foundation / Firm Name : Foundation / Firm Name : OUR LAB
Admin User Name : Admin Admin User Name : Admin
Admin User Password Admin User Password
Password Confirm Password Confirm
Reminders : - You must create a new user to be able to read.

- Admin user is only used to create a new user (user), update program,
update Kit Constants and change Titer Constants.

- Technicians are not recommended to use the admin user.

1 Biosione-[L1A - Logi Name Admin

e Database Reports Options  Help

Template Reader  Printer Exit
Setup Setup

m Making Animals Healthier and Safer®

- After the last few steps, you can use it safely.
You can make the final edits by following the links below in order :

- Update Application
- Update Kit Constants
-> Foundation Information

-> New User (Technician)

- Setup Reader

Back to Index

ﬂ www.biostoneah.com
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General Information

Update Application BioStone Animal Health

-> Help
-> Update Application

- Itis recommended to update on initial installation.
- After the update, the program will close and reopen.
- Only the 'Admin' user can perform the update.

There i 2 mew version. Woukd yoe lie 10 update ! Yo are st the tatest 0,875 version

- O
<4\® Making Animals Healthier and Safer® «4*® Making Animals Healthier and Safer®

Update Kit & Dictionary

- Help - Help
-> Update Kits -> Update Dictionary

- Itis recommended to update on initial installation.
- With this update you get the latest Kit validation terms and language dictionary.
- Only the 'Admin' user can perform the updates.

d Safer® E“ 1 Safer®

Back to Index
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Foundation Information

-> Options
-> Foundation

- Only the 'Admin' user can perform the Foundation Update.

- You can add laboratory name, address and logo.

The information here will appear in the PDF report headers.

- You can change the ADMIN password.

Changes made with the "Update" button are saved.

a

L2)]

File Database Reports | Options

Switch [Foundation| X erstsn
User

Language

Foundation Info

Foundation |Foundation

Address 1 |Address 1

Address 2 |Address 2

Address 3 |Address 3

Update

Change Admin Password

New User (Technician)

- Database
- Technician

- A new technician can be added from this section.
- Technicians' password, name and code can be changed.
- Admin user is authorized for this operation.

>

BioStone Animal Health
x
‘ d Safer®
Technician .
Disable the user:
R Do oo .
o b B - Save Cancel

The "Passive" option is ticked.
The changes are saved with the
"Save" button.

Back to Index
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Language Selection BioStone Animal Health

-> Options
-» Language

- All users can choose language.
- Please report any translation errors to Biostone.
- With the 'Help->Update Dictionary' option you can have the latest revisions.

# BioStone-ELISA v 0,870 - Login Name: Admin - o X

)
File Database Reports | Options | Help

BE tngiisn =

Tuvkge

e

T espaiol
ll==x

Switch  Foundation
User

<4 Making Animals Healthier and Safer®

- Options
- Switch User

- All users can use this screen.
- The 'Switch User' screen is the same as the opening screen of the program.
- Itis designed for easy switching between users.

File  Database  Report ptions | Help

Switeh] Foundation B Eroven Y
User

=]
<4\

BIOSTONE ™

ANIMAL HEALTH

BioStone ELISA 0.87b
BioStone ELISA is a simple program developed exclusively for outhorized
laboratories where you can safely store and analyze test results.
Copyright 2022 - BioStone ELISA Version 0.87b “-®

User Code @

User Password

Back to Index
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Setup Reader BioStone Animal Health

-> File
-> Reader Setup

In the first installation, you must choose a name and define it as 'default' and save it.

1]
o)
File | Database Reports Options Help

Read  Template | Reader Printer Exit

Setup Setup

Reader Setup X
Reader ComPortName BioTek 200TS
BioTek ELx808
BioTek ELx800 Fort
BioTek 800TS BaudRate i
DataBits i
Parity hd
StopBits ~
Save by Default
M d Safer®

Select the device you are using from the list.

Select the communication port (COM XX) where your device is active.
Define the device by pressing the 'save' button and the ‘by Default' button.
Some 'reader' models may not appear in the list.

Ask a BioStone representative for help for the initial setup.

Make a note of your reader's working setup settings.
You can check these settings for any connection problem.

Back to Index
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Template prepa ration BioStone Animal Health

- File
- Template

Step-1 -Assay group is selected. ( Ruminant / Poultry / Swine / Equine )
-The kit to be used is selected. (In the example 10081 AHSV was selected. )
-A new one is created by clicking the "New Template" button for each new reading.

) Admin is not authorizedin
fie | Omaboe Repors_ Optiors el this section. Technicians only.

Read [Template| Reader Printer  Exit

Setup Setup
€ Termplate Manages D x
RUMINANT ‘ ‘ POULTEV SWINE ‘ EQUINE
Equine
lAssay Code  KnCatho it Nome |
Te 10012 Asurx - T.equiperdum (TE) Antibody Test Kit (Dourine) Neow Tempiate
[ 10013 AsurOx - Burkholderie Malles Antibody Test Kit |
| Tev 10025 ‘AsurDx - T.evansi Antbody Test Kt | e cronta Tomenite
TEQ 10035 AsurDx - Theilara equi Antibody Test kit |
sabc 10036 ‘AsurDx - Babesia caball Antibody Test Kt
£ 10059 AsurDx - Equin nfectous Anemia (E1A) Antibody Test Kit | oelte Tempiote
sy 10081 ‘AsurD - Afrcan Horse Sickness Virus (ANSY) Antbody Test Kt

e | \thie

Step-2 The program generates a "Template Name" name by default.
You can change or add this name.
For example :“20220314-10081 ”

n 2 Template Editor - o x
- v Template Name 20220314-1008 1 [T ]
I virection Row © Position Column 1~ PosionRow A
RUMINANI; BOUE a | s | e | 7 [ 8 [ 9| 0 ul ] ok
Eqiine Cancel
Assay Code KitCatNo
TE 10012
BuMa 10013
Tev 10025
TEQ 10035
BabC 10036
EIA 10059
AHSV. 10081
Key Start Type Case Count Population e
1A-1B Negative
1c-1D Positive 2 Insert
N [ ABC-20sample 20 Delete
Template List Case | Population  Comments Vaccine
Insert Date Template Nal e
S
Reason Monitoring v Owner ABC FARM o=
Sample Date  [12.03.2022 o
Sample Type  Serum v
2 I—

‘Direction’, ‘Position Column’ and ‘Position Row’ are used to determine the plate position.

Back to Index
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Template prepa ration BioStone Animal Health

Step-3 Inthe "Count" column, enter the ‘Positive Control’, ‘Negative Control’ and ‘Samples’.

3 Sub tabs :

Template Name |20220314-10081 AHSV 20w ‘ T | FT | G || G
Direction Row « Posion Column 1~ PosonRow A v Population |
4 ‘ 5 ‘ 6 ‘ 7 ‘ 8 ‘ 9 ‘ 10 | 11 | 12 | 0ok Veterinarian ~ | *** | Animal Type v
Cancel Grower v |7 | Species v
Complex ~ " Breed1 v
Location v |7 | Breed2 v
Sub-Location v
A —
Case | Population | Comments ] Vaccne
Periodic control for Bam o. 3
Key Start Type Case Count Fopulation New gz:mt ‘
1A-18 Negative
1C-10 Positive 2 Insert
» - ABC-20sample 20 Delete zﬂ,‘:g:{‘ ‘

—

Case | Population = Comments Vaccine
Case | Population | Comments Vaccne ]
Case |ABC-20sample
Vaccine Age 60

Vaccine Name |Vaccine AHSV ICP4

Reason Monitoring - Owner ABC FARM o=
Sample Date 12.03.2022 -

Sample Type  Serum v

[ YR O

CASE Tab : Required fields : 'Owner’, 'Case' and 'Sample Date’.
POPULATION Tab : Optional fields.

COMMENTS Tab : Optional annotation fields.

VACCINE Tab : Optional vaccine information fields.

REMINDER :

- While preparing the template, attention should be paid to the selection of the Kit.
- Template Name' contains the kit number and date by default. (Can be changed)
- Check the layout of the planned plate and template plate twice before reading it.

- For data security, every reading is recorded and cannot be deleted.

Back to Index
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Template preparation

BioStone Animal Health

Examples of using a partial plate:

Neg Control
Pos Control
Samples
Case
Direction
Position Col.
Position Row

Neg Control
Pos Control
Samples
Case
Direction
Position Col.
Position Row

Neg Control
Pos Control
Samples
Case
Direction
Position Col.
Position Row

:35

: Row

:3

:3
:12-30-2-46
14

:Row

:3

:3
:12-30-2-46
14

: Column

01

A

3 Template Editor

Template Name| 20220314-10011 MG Ab - 35w

Direction. Rowr v Position Column| 8 v PostionRow ~C v
1 | 2 [ 3 [ a]s][e |7 ]8>

a

3

c

>

E

F

G

"
Key Start Type Case Count Population
|sc-sc Negative 1

8D-5E Positive 2

Case | Population = Comments Vaccine

S
S —

Reason

- -
s e
Sample Type ~

e —

ok

Cancel

Delete

) Template Editor

(EA——

Template Name| 20220314-10011 MG Ab - Multiple clients - 4

Direction Row

v Postion Column 1~ PostionRow A -

Key Start Type case Count Population
1A1C Negative 3
1D-1F Positive 3
Data ABC -12sample 12
Data ZYC -4sample 30
Data DEF - 2sample 2
Data QWR Farm - 46sample 46|

Case | Population =~ Comments Vaccine

Case 2

Reason

Case QUR Farm - 46sample

~ ‘Owmer ABC FARM | ==
sarpie e
Sample Type ~ Serum v

.

ok

Cancel

Delete

(E—

¥ Template Editor

Template Name 20220314-10011 MG Ab - Multiple clients - 4

Direction Column

~ Postion Column 1 v PosonRow =~ A

Key start Type Case Count Population
A1-A3 Negative 3
Aa-A6 Positive 3
A Data ABC -12sample 12
8 Data Z¥C -4sample 3
c Data DEF - 2sample 2
b Data QWR Farm - 46sample 46
Case | Population | Comments | Vaccine

Case QR Farm - 46sample

Ok

Cancel

Insert

Delete.

<A\

MoSTONE”  Making Animals Healthier and Safer®

Case 2
Reason ~ ‘Owner ABC FARM 20 hand
Sample Date
Sample Type  Serum v
soplede ||
2 JO—— Back to Index
www.biostoneah.com
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Read BioStone Animal Health

- File
- Read

ile | Databsse Reports Options  Help

Read | Template Reader  Printer Exit
Setup  Setup

£ pute asd - @ Input Data Manually
-y sy W ol
’ ‘ ' POI er SWINE EQUINE
Poultry
Amay Code  Ktcatho e tame
10011 AsurDx - M.Gallisepticum (MG) Antibody Test K& Rond
10015 AsurOx - M.Synoviee (MS) Arntibody Test Kt (Chickens)
10016 AsurOx - Mycoplasma MG/MS Antody Test Kit (Chuckens) Input Data Manually.
1007 AsurDx - Avien Ifenza (A]) Antody Test Kt
10018 AsurOx - Newcastle Disoase Virus (NOV) Anbbody Test K&
10024 AsurDx - Reticuloendotheliosis Virus (REV) Antibody Test Kit
10026 Aur - v Lt Virus (ALV) Ag Test ki
10027 ASUrDX - Avian Lewkosis Virus (ALV) Antbody Test Kit
10028 AsrDx - Aven Leukuss Virus Subgroup ] (ALV-1) Antbody Test it
10029 AsurDx - Avian Reowrus (RED) Antibody Test Kit
10000 Asirl - Hectious Bursal isease (D) Antbdy Test Kt
10032 Asur - wven Encophaomyelcs (A6) Antbody Test Kt
10033 AsurDx - Chicken Anemia Virus (CAV) Antbody Test Kit
1004 AsDx - Foud Adencrus Group 1 (FADV-) Antbody Test ke
10037 AsurOx - Infectious Laryngatrachedts (ILT) Antibody Test Kit
T A _ Saf. ®
: and Safer
14m2022 20220314-10011 MG Ab - Wil cheris 4
sn202 20220304-10030 B0
w22 202202281000 -92
w022 2022622810050
wna2 022022810078 Close
28,02.2022. 20220228:10091 *92 =
B e e

Check your selection for Kit and Template File.
“Read” button : Reads from the reader.

“Input Data Manually”’ button : OD values can be entered manually.
(Copy-Paste can be made from any file.)

Back to Index
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BioStone Animal Health

with Reader Device :

Step-1 - The reader is turned on and the plate is placed in the reader.
- Assay group is selected. ( Ruminant / Poultry / Swine / Equine )
- The kit to be used is selected. (In the example 10011 MG Ab was selected. )

Step-2

- Press the 'Read' button.
- The program displays the selected Kit and Template name and asks for confirmation.

LY ~ o
RUMINANT POULT!Y SWINE EQUINE
Poultry
Assay Code KitCatho Kit Name ~
MG Ab 10011 AsurDx - M.Gallisepticum (MG) Antibody Test Kit e
s Ab 10015 ASUIDX - M.Synoviae (MS) Antibady Test Kit (Chickens)
MG/MS Ab 10016 AsurDx - Mycoplasma MG/MS Antibody Test Kit (Chickens) Input Data Manually
EED 16017 A9 Warning X
NDV Ab 10018 A K
w0 Huors el Set the Reader value to 630 nm.
ALV Ag 10026) Aq Insert the plate into the reader L
ALV Ab 10027
ALV Ab 10028 Ad Kit Name : AsurDx - M.Gallisepticum (MG) Antibody Test Kit [
REO AD 10020 : 5
B0 Ab o ad Template : 20220314-10011 WG Ab - Multiple clients - 4
AE Ab 10032 Ad
| Are You Sure?
CAV Ab 10033 Ag
FADV-1AD 10034
T 10037
BY 10045 .
Template List
Insert Date Template Name ~
14.03.2022 2022031410011 MG Ab - Multiple clients - 4
4.03.2022 20220304-10030 18D
28.02.2022 20220228-10030 -02
28.02.2022 20220228-10030
28.02.2022 20220228-10078 Close
28.02.2022 20220228-10091 %92 v

[ I

- The scanning process may take 1 minute or more.

- The following screen is displayed while reading.

In case of error or problem, it can be read again with the ‘Re-Read Plate' button.

\Well No Well Name

Elld Titer Result Case Owiner

<No data to display>

validation |S/P Amean Titer % Amean ConditionName Status
Conditions  |c/p cmea Titer % Gmean
s/p oV Titer % CV
S/P Min. Titer % Min. <o data to display.
S/P Max. Titer % Max.
Case Sample Age SampleDate  Vaccine Age Vaccine Date  Vaccine Name
ABC -125ample 0 0
2¢C-4sample 0 0
DEF - 2sample 0 0
0

QWR Farm - 46sample

013.03.2022

save-Close

Re-Read Plate

Close

Back to Index
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BioStone Animal Health

with Reader Device :

Step-3

OD values read from the reader can be examined here.

Vaccination information for each “Case” can be optionally entered at the bottom of the screen. (1)
If the test validation is correct, "Validation Conditions : Valid" is displayed. (2)

See the readings on the plate design figure. (Plate button) (3)

CAUTION :

- If there is a "Validation Conditions : Invalid" warning, positive and negative control values are inconsistent.

- Check the kit constants. If there is any inconsistency with the data in the manual, do the kit update and
read it again immediately.

- Read the plate with the program provided by the device manufacturer and compare the results.

Step-4

I
T - - o B T o e B T
— anse| wis ase woso| aoes| ases] wese| ases wew] asos wew nowl B ]
" i owe omo asw Gow Gos w0 o0 o0 o 0000 0000
I R R N —
101 Neg BCp 125 0D LAS 1930 0400 0000 0000 0000 0000 0000 0000 0000 0000 0000 0,000
- =
me o sous aio 0o ame aww aoe awo weo aso aoco aso wees aoos
ST soua i awe ome amo sow e ase as 4o e wew amee
F ~m—T =7
’ e o a1 asse 0me aow 0o 00 80 0000 000 0000 0000 0000
X 138 e 8D 125 80 LAl " 0100 0,600 0000 0000 0000 0000 0000 0000 0000 0000 0000 0,000
= - o
. - woua
T I T =
S/P Amean 16,584 Titar % Amesn 334,167 Candiboréame Status.
Conditions \ 5/p Gmen 14,19 Titer % Gmean 272,412 VESPOOD True
vl P sem TherdCv 188745 jvesecee Troe
- 500 bt
o 02 nabeirel
N cose
=2
s
(2 [— cime [ e .

‘Kit Expiration Date’ and ‘Kit Lot Number' fields must be filled in mandatory.
Press the ‘Save-Close' button to save the transaction.

Plate Reader - AsurDx - M.Gallisepticum (MG) Antibodly Test Kit

WellNo  WellNeme 0D  S/P Titer Result Case Owner '~
1A Neg. 0,010
24 Neg. 0,060
34 Neg. 0,140
4A Pos. 0,220
54 Pos. 0,300
6A Pos. 0,370 ( '
TA Samplel 0,550 211,45 5182 Pos /ABC -12sample ABC FARM
34 Sample2 0450 16740 4017|Pos ABC -12sample ABC FARM
9A sample3 0710, 28194 7090 Pos ABC -12sample ABC FARM
10A Sampled 0,790 317,18 8062 Pos ABC -12sample ABC FARM
1A Sample5 0,220 66,08 1458 Pos ABC -12sample ABC FARM
12A Sampleé 0,300 101,32 2324 Pos /ABC -12sample ABC FARM
18 Sample? 0,015 2423 0|Neg ABC -12sample ABC FARM
28 samples 0,070 0,00 0/Neg ABC -12sample ABC FARM
3B Sample9 0,150 35,24/ 735|Neg /ABC -12sample ABC FARM
48 Sample10 0,230 70,48 1565 Pos ABC -12sample ABC FARM
v
- Cammintt 210l ane 2124 0ar [rraE— nor crom R
Validation |S/P Amean 158.076 Titer % Amean 3912.367 Conditiontiame Status
Conditions | o/p Gmea 0 Titer % Gmean 0 VEsPCOD [True |
Valid |SPOV 126474 Titer % V. 3314.852 VCSPCOD - NCOD. [Tree |
S/PMin.  -24.220 Titer % Min. 0
S/PMax.  585.903 Titer % Max. 15737
Case Sample Age SampleDate  Vaccine Age Vaccine Date  Vaeeine Name
ABC -12sample 0 0
7Y€ -4sample 0 0
DEF - 2sample 0 0
QWR Farm - 46sample 30/13.03.2022 ENEXERTZENN v accine MG 001
|
2 IO—— s
Back to Index
www.biostoneah.com
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Read BioStone Animal Health

Manual Read — Copy/Paste :

Step-1 Copy the data in the Excel or other file.

AsurDx™ M. Gallisepticum (MG) Antibody Test Kit

1| wiostone
2
2 PLATE LAYOUT DIAGRAM
4 1 2 3 a 5 5 7 8 9 10 11 12
5 A Negl Somple5 | Semplel3 | Sample2l | Sample29 | Semple37 | Sample45 | Sample53 | Samplel | Samplesd | Sample77 | SamplegS
6 B Nez2 Sample6 | Sample14 | Sample22 | Sample30 | Somple38 | Sample46 | SampleS4 | Sample62 | Sample70 | Sample78 | Sample8S
7 c Pos1 Ssample7 | Samplels | sample22 | Sample31 | Sample39 | sample47 | SampleS5 | Sample63 | sample7l | Sample79 | Sampleg?
8 D Pos2 samples | Samplel6 | Sample24 | Sample32 | Sample0 | Sampleds | SampleS6 | Samplesd | Sample72 | Sample80 | Sampless
9 E sompler | somples | samplei7 | samplezs | sampless | samplea1 | sompless | samples7 | sampless | sample7s | samples1 | sampless
10 F Sample2 | Samplel0 | Sampleis | Sample26 | Sample34 | Sampledz | Sompleso | SampleSs | Samples5 | Sample7d | SampleB2 | Samplesn
11 3 Sample3 | samplels | sampleio | sample27 | Sampless | sampleds | samplesi | sampless | Sample67 | sample7s | samples3 | samplesl
12 H Sampled sample12 | Sample20 | sample28 | Sample36 | Sample4d | Samples2 | Samples0 | Sample68 | Sample76 | SampleB4 | Sampleo2
13
14 0D630 INPUT
15 1 2 3 4 5 6 7 8 9 10 11 12
16 A 0,01 0,06 0,14| 0,22 03 0,37] 0.55 0,45 0,71 0,79 0,22 03
17 B 0,015 0,07] 015 023 0,31 0,38 0.56| 0,46 0,72] 03| 023 031
1% c 07 o0s| 0,15| 0,24 0,32 0,39 0,57 0,47 0,73] 09| 0,24] 032]
19 D 072 0,09] 0.17] 025 033 03] 0,58] 0,28] 074 1 025 053]
20 E 0,02 01 0,18| 0,26 0,34] 0,41] 0,59 0,49 0,75] 11 0,26 0,34
21 F 0,03 0,11 0,19| 0,27 0,35 0,42] 06| 0.5 0,76| 12 0,27 0,35
22 [} 0,04 0,12] 02 0.28 036 043 061 0.5| 0,77] 13 0,28] 0,36|
2z H 0,05 a,;ﬂ 0,21] 0,29 0,385 0,44] 0,52 07 0,78| 1,4] 0,29 0,365
24

Step-2 Paste the data by pressing the “Paste from Clipboard” button at the top of the “Manual
Read” screen.

Then finish the recording process by pressing the “Save Close” button.

Manual Read X
Paste From Clipboard Close
1 2 3 4 5 6 7 8 9 1e 11 12
A 0.13 0.25 0.65 11 19 3.4 0.15 0.16 0.18 0.2 0.2t 0.22
B 0.13 0.3 0.7 1.2 2| 3.5 0.15 0.16 0.18 0.2] 0.21 0.22
C 191 0.35 0.75 13 21 0.15 0.15 0.16 0.18 0.2] 0.21 0.22
D 193 0.4 0.8 1.4 25 0.15 0.15 0.16 0.18 0.2] 0.21 0.22
E 0.11 0.45 0.85 1.5 3 0.15 0.15 0.16 0.18 0.2] 0.21 0.22
F 0.13 0.5 0.9 16 31 0.15 0.15 0.16 0.18 0.2] 0.21 0.22
G 0.15 0.55 0.95 1.7 3.2 0.15 0.15 0.16 0.18 0.2] 0.21 0.22
H 0.1 0.6 1 1.8 33 0.15 0.15 0.16 0.18 0.2] 0.21 0.22
Save-Close

Back to Index

ﬁ www.biostoneah.com
can Page 14/18
MoSTONE”  Making Animals Healthier and Safer®



BioStone Animal Health

Manual Read - Copy/Paste :

Step-3

OD values read from the reader can be examined here.

Vaccination information for each “Case” can be optionally entered at the bottom of the screen. (1)
If the test validation is correct, "Validation Conditions : Valid" is displayed. (2)

See the readings on the plate design figure. (Plate button) (3)

CAUTION :

- If there is a "Validation Conditions : Invalid" warning, positive and negative control values are inconsistent.

- Check the kit constants. If there is any inconsistency with the data in the manual, do the kit update and
read it again immediately.

- Read the plate with the program provided by the device manufacturer and compare the results.

Step-4

I
T - - o B T o e B T
— anse| wis ase woso| aoes| ases] wese| ases wew] asos wew nowl B ]
" i owe omo asw Gow Gos w0 o0 o0 o 0000 0000
I R R N —
101 Neg BCp 125 0D LAS 1930 0400 0000 0000 0000 0000 0000 0000 0000 0000 0000 0,000
- =
me o sous aio 0o ame aww aoe awo weo aso aoco aso wees aoos
ST soua i awe ome amo sow e ase as 4o e wew amee
F ~m—T =7
’ e o a1 asse 0me aow 0o 00 80 0000 000 0000 0000 0000
X 138 e 8D 125 80 LAl " 0100 0,600 0000 0000 0000 0000 0000 0000 0000 0000 0000 0,000
= - o
. - woua
T I T =
S/P Amean 16,584 Titar % Amesn 334,167 Candiboréame Status.
Conditions \ 5/p Gmen 14,19 Titer % Gmean 272,412 VESPOOD True
vl P sem TherdCv 188745 jvesecee Troe
- 500 bt
o 02 nabeirel
N cose
=2
s
(2 [— cime [ e .

‘Kit Expiration Date’ and ‘Kit Lot Number' fields must be filled in mandatory.
Press the ‘Save-Close' button to save the transaction.

Plate Reader - AsurDx - M.Gallisepticum (MG) Antibodly Test Kit

WellNo  WellNeme 0D  S/P Titer Result Case Owner '~
1A Neg. 0,010
24 Neg. 0,060
34 Neg. 0,140
4A Pos. 0,220
54 Pos. 0,300
6A Pos. 0,370 ( '
TA Samplel 0,550 211,45 5182 Pos /ABC -12sample ABC FARM
34 Sample2 0450 16740 4017|Pos ABC -12sample ABC FARM
9A sample3 0710, 28194 7090 Pos ABC -12sample ABC FARM
10A Sampled 0,790 317,18 8062 Pos ABC -12sample ABC FARM
1A Sample5 0,220 66,08 1458 Pos ABC -12sample ABC FARM
12A Sampleé 0,300 101,32 2324 Pos /ABC -12sample ABC FARM
18 Sample? 0,015 2423 0|Neg ABC -12sample ABC FARM
28 samples 0,070 0,00 0/Neg ABC -12sample ABC FARM
3B Sample9 0,150 35,24/ 735|Neg /ABC -12sample ABC FARM
48 Sample10 0,230 70,48 1565 Pos ABC -12sample ABC FARM
v
- Cammintt 210l ane 2124 0ar [rraE— nor crom R
Validation |S/P Amean 158.076 Titer % Amean 3912.367 Conditiontiame Status
Conditions | o/p Gmea 0 Titer % Gmean 0 VEsPCOD [True |
Valid |SPOV 126474 Titer % V. 3314.852 VCSPCOD - NCOD. [Tree |
S/PMin.  -24.220 Titer % Min. 0
S/PMax.  585.903 Titer % Max. 15737
Case Sample Age SampleDate  Vaccine Age Vaccine Date  Vaeeine Name
ABC -12sample 0 0
7Y€ -4sample 0 0
DEF - 2sample 0 0
QWR Farm - 46sample 30/13.03.2022 ENEXERTZENN v accine MG 001
|
2 IO—— s
Back to Index
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Plate Report

-> Reports
-> Plate Report

BioStone Animal Health

It creates a report of a selected plate, regardless of the customer.

LLE e No - o pad
File  Database  Reports | Options Help
| Plate | Owner Owner-Kits
Report Report Report
Reports
&3 Plate Report - | X
Starting Date |1.03.2022 | KitCatho v
Close
EndDate  |30.03.2022 | Poust
Date Time ASSB‘;C““ KitCattio S/P Amean 57,785 S/PMin. 1 Titer Amean 1288,761  Titer Min. 15
29.03.2022 [15:26 |MG Al 10011
/P Gmean 42,586 SPMax. 1 Titer Gmean 903,45 Titer Max. 4850
20.03.2022 |15:36 BTV 10014 - 0560
20.03.2022 |15:51 |APP 10079 . WEED  EERED
20.03.2022 |15:56 |EIA 10059 WellNo  WellName 0D s/P Result  Titer TiterGrupNo ~
1A |Neg. 0,010 0 0
18 |Neg. 0,015 0 0
1C |Pos. 0,700 0 0
10 |Pos. 0,720 0 0
1E [sampler | 0,020 1,004|Neg 15 0
IF  |samplez | 0,030 2,439 |Neg 40 0
16 |Sample3 | 0,040 3,874 Neg 66 0
1H  [sample4 | 0,050 5,308 Neg 93 0
24 |samples | 0,060 6,743 |Neg 121 0 v
Print

Existing reports are displayed by selecting “Starting Date” and “End Date”” and “Kit No”.

If the “List” button is pressed without making any selection, the reports of the day are listed.
Press the ‘Print' button for the preview report.

You can save the report as a PDF or send it directly to the printer.

2 SUROR y PLATE REPORT ‘ )
avoretory neme 74 sbaratery rame
Resortute ReportDme 1301302
it Name AsurDu - Biuetongue Antibody Test Kit ot Lotw LOT0091 Ot Name AsurDs - Bluetongue Antibody Test Lit it Low LOT0091
oz Cutolt =04 apiry Dute so13023 Eapiry Date so12023
e o G Ocose
e wes
“ poo weos
i pres wos
pro wes
“© ABC wes
fin pro wos
3 asc wos
» AsC wo3
" nec wes
oo wes
pres wes
pro wos
‘W;GD‘;P‘ § ‘ omi o
pro wos
= Somple Age Somple Dsie _ Vocne Age_Vecdoe Neme Vecdne Date pro wos
2 55 VECTORMUNE HVT-NDV 301202 e wee
: i proges wos
4“0 BI0-VAC NOV /10 8¢ wos
s wes
e o e code oo wos
s wes
pro wes
progen wos
prose wos
101 0 asc wos 80 wos
12 0 A wos aec wos
192 0 s wos A8c - s wo3s
10 wes progis wos
248 0 wo3 S ¥ wo3
309 0 Asc-s wos progx e
W 0 A wos asc wos
i s aac - stabt wos
e - progie: we
® sod progine: wes
2m6s weg wos x wou
3125 Neg wos wod
3385 Neg wos wod
P o 08 samoess wos

'Plate Report' outputs the entire plate report regardless of customer(owner).
Use other reports for customer-specific evaluation.

Back to Index
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Re 0]0) rts BioStone Animal Health

Owner (Customer) Report

-> Reports
-> Owner Report

n

File Database Reports | Options Help

Owner
Report

15:26:49 MG Ab

15:36:57 @1V

Nome

XYZ Farm

X¥Z Farm

e
Time 15:36:57
e It gives the opportunity to

e ot S et Tok 8 separately report more than one
customer in a plate.

& i Summary Detailed

Available reports are displayed by selecting “Start Date” and “End Date”. If the "List" button is pressed
without making any selection, the reports of the day are listed. A report is selected from the list on the left.
Customers included in the selected report are displayed on the right screen. By selecting one or more
customers, the report of that customer is selected. Press the "Detailed" or "Summary" button for the report.
You can save the report as a PDF or send it directly to the printer.

PLATE-OWNER DETAILED REPORT PLATE-OWNER SUMMARY REPORT

Laboratory name Laboratory name
Kit Lot No. LoToos1 Read Date  :13.01.2022 Kit Lot No LOTo091 Read Date :1301.2022
BTV 122235
Assay Code Read Time hssaycode BTV Read Time 1122235
it Name. AsurDs: - Bluetongue Antibody Test Kit Report Date :13.01.2022
Kit Name AsurDx - Blutangue Antibody Test Kit Report Date :13.01.2022
Pos. Cuteff  :>=0.4 Tech to1
Pos. Cutoff  :==0.4 Tech 101
Kit Expiry Date : 5.01.2023 Page 2/5 =
Kit Expiry Date ©5.01.2023 Page 172
wos ABCFARM
Case : ABC- Staba. sfe Titer wo1 Dallas Farm
THer Group Frequency Amean 5227 Amean 118181  Sample 52 Case : Dallas 011 sfe Titer
Gmean 2877 Gmean 58883 Nez. 29
20 2 TierGrous Freauensy Amean 1145 Amean 21600 Sample 3
1 QU 5318 CVw 128889 P 2 3 Gmean 1146 Gmean 21600 Nez. 3
o Min 521 Min 9100 Doubtful 0 W% 000 &% 000 b o
H Max 18228 Mox  4.408.00
i o o 5 Min 1145 Min 21600 Doubtful 0
—Sample  ___ Veeine B Max 1146 Max 21600
. Age :63 hge 55 3
© sample Vacdine
. Date 12012022 Date 13012022 | ___sample __ vacdne
0 2 4 6 8 10 12 W 16 18 Name : VECTORMUNE HYT-NDV Age 177 Age
Titer Groups Case Comment Date 12012022 Date
02 4 & 3 10 12 14 16 13 Name
Titer Groups Case Comment
WellNo Well Name on sre Titer Group Result The field where notes about the case can be written
1 Samplel 0110 573 101 0 Neg
1 Sample2 0130 677 122 0 Neg
wo3s ABCFARM
16 Samples 0150 781 122 o Neg
SABC- [ 7/ S— Titer
H Somplea 0100 521 s 0 Neg Case : ABC- Stabd pr— o t1s1en semole 2
mean mean ample
2 samples 0250 1302 288 0 Neg Titer Group Frequency P
N » Gmean 2877 Gmean 58883 Nee 29
28 Somples 0300 1563 03 Neg wx sis % 18 Pe 2
2 sample? 0350 1823 a8 o Neg 18 Min 521 Min s100 Douful ©
0 somples 0400 2083 a1 1 Neg g Max 18220 Max 440800
1
% samplea 0450 2344 a1 Neg S . sample Vasdine
2 Sample10 0500 2604 s20 1 Neg . P po—
26 Sample11 0550 2865 ss6 1 Neg , Date ‘12002022 Date 3002022
1
2H Somple12 0600 3125 65 Neg S S S e Name : VECTORMUNE HVT-NDV
38 Sample13 0850 33ss 704 1 Neg Titer G roups Case Comment
E Sampleld 0700 3646 783 1 Neg
ES Sample1s 0750 3906 a2 1 Neg

With 'Plate-Owner Report', it gives a single customer report and/or multiple customer reports on a plate.
This report can be used for customer-based evaluation.

Back to Index
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BioStone Animal Health

Kit Report

-> Reports
-> Kit Report
-
o
File  Databa: . Options  Help
Plate Owner Ovmer-Kits
Report Report Report
€ Repot Ouner. o
on
I s
ABC Farm  ABC Farm |
s G i!ﬂx—w—-hl—h!—l
MORSE? Farr HORSEZ Farm Select A Un-Select All
SPEED Farm  SPEED Farm
| select Growp utCatho Kithame
| [ poultry 10011 AsurDx - M.Galisepticum (MG) Antibody Test Kt
| [ Swine 10079 AsurDx - Acinobacilus pleuropneumoniae (APF) Ab Test
[ equine 10053 AsurDx - Equine Infectious Anemia (EIA) Antibody Test K
<

Creates all reports for the
selected customer and kit.

As the first step, a customer (Owner) is selected. If there are registered tests belonging to the selected
customer, the results are listed in the right section. A report can be obtained by selecting one or more of
the listed results. The received report includes all reports of the selected customer and kit. ( If you want

to report for a single scan, use the 'plate-owner' reporting. )

Press the "Detail" or "Summary" button for the report. You can save the report as a PDF or send it directly

to the printer.

JRR— o Z J—

Poarestns S R Elate oTeest
P ._ T, 13918 e AkrDn ML st G| Aot Tt 41
s comm - oo 3300

weine wane O
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